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Excel  4.0  responds  to  the  core  Apple  events  defined in  the  Apple  Event
Registry and defines 11 objects and approximately 65 properties that can be used
as parameters to these Apple events.  Using these events, objects, and properties,
you can send data to and retrieve data from Excel; you can format worksheets;
and you can create, format, and retrieve charts.  Most events in the miscellaneous
standard suite are supported, and Excel defines two additional Apple events.  One
of these, the “Do-Macro” event, allows a list of Excel functions or macros to be sent
to Excel for evaluation and/or execution.

The  first  part  of  this  document  lists  the  Apple  events  to  which  Excel
responds.  The second section is a detailed description of Excel’s objects and their
properties.  Each object description lists which events apply to it,  and includes
some examples. The style used is similar to that of the Apple Event Registry.  The
third section describes Excel's  additional  Apple events.   It  is  assumed that the
reader is familiar with Apple events, the Apple Event Object Model, and the Apple
Event Registry.

Note:   Setting  some  properties  have  the  side  effect  of  changing  the
selection.  This is due to internal Excel limitations.  In future versions of Excel,
Apple events may not have the same effects on the selection.  Thus, you should
not make any assumptions about how Apple events affect the selection (unless the
event explicitly changes the selection).

I.  Apple Events
The Core Suite
Clone Get Data Size
Close Move
Count Elements Open
Create Element Print
Delete Quit 
Do Objects Exist Save
Get Data Set Data

Apple will be providing system handlers for the Get Class Info and Get Event Info 
events, so there is no code in Excel to respond to these.

The Miscellaneous Standards Suite
Begin Transaction End Transaction
Copy Paste
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Create Publisher Redo
Cut Revert
Do Script Undo
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The Table Suite
The table suite does not define any Apple events, though it defines some 

objects.  Excel supports and extends the definition of these objects.

Custom Events
Recalc
DoMacro

II.  Objects and Their Properties

1. The Cell Object

Class: 'ccel'
Default Data Type: 'cell'

Notes:  

• When the direct parameter of a GetData or SetData event is a cell object
(as opposed to a property of a cell object), the data that is returned or the
data that is set is an Apple event record corresponding to the cell  object
(which is described below).  As a "feature," however, if the data to be set is
text or numeric, then Excel automatically sets the formula of the cell.  Thus,
you can say "set cell  1  of  row 1 of  the document named Worksheet1 to
=ROW()*COLUMN(),"  rather than explicitly  stating "set  the formula of  cell
1 ..."

• Many properties can be set to any text or numeric data.  Either can be sent
with  a  SetData  event,  since  the  Apple  Event  Manager  will  automatically
coerce these as needed.  In response to a GetData event, however, Excel will
always return TEXT, unless it is asked to coerce to a numeric type (with the
requested type parameter to the GetData event).

3



Apple Events and Microsoft Excel 4.0

Properties

Protection
Description:  The protection of the cell
Property ID: 'ppro'
Access: read/write
Data Type: Enumeration:

Read Only 'nmod'
Read/Write 'modf'

Notes:  This property corresponds to the locked checkbox of the Cell
Protection  command  in  the  Formula  menu.   In  Excel,  the
protection of all cells is read only by default, but this setting does
not take effect unless document protection is also read only.

Formula
Description:  The formula contained in the cell
Property ID: 'pfor'
Access: read/write
Data Type: Any text or numeric data
Notes: There  is  no  difference  betwen  setting  the  formula  and

value of a cell.

Value
Description:  The value in the cell
Property ID: 'pval'
Access: read/write
Data Type: Any text or numeric data
Notes: There  is  no  difference  betwen  setting  the  formula  and

value of a cell.

Text
Description:  The text in a cell
Property ID: 'ptxt'
Access: read-only
Data Type: TEXT
Notes: This  returns  the  actual  formatted  text  in  a  cell.  For

example, if a cell is formatted to show dollar values, getting the
text of the cell will show the dollar sign.
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Number Format
Description:  The formating code for a cell as indicated in the Number

dialog in the Format menu
Property ID: 'pnft'
Access: read/write
Data Type: TEXT

Alignment
Description:  The horizontal alignment of a cell's contents
Property ID: 'alig'
Access: read/write
Data Type: Enumeration

General: 'gnrl'
Left: 'left'
Center: 'cent'
Right: 'righ'
Fill: 'fill'
Justified: 'just'
Center Across Selection: 'cnsl'

or Numeric/Text: Instead of an enumeration code, you may pass
a  numeric/text  value  which  is  the  same  value  used  in  the
ALIGNMENT macro.  See the Excel function reference for further
details.

Notes: This property corresponds to the horizontal radio group in
the Alignment dialog under the format menu.  Vertical alignment
and orientation  are  not  accessible  via  a  property,  but  can be
accessed with the DoScript AppleEvent.
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Left Border
Right Border
Top Border
Bottom Border

Description:  The four borders of a cell
Property ID: 'plbr', 'prbr', 'ptbr', 'pbbr'
Access: read/write
Data Type: Enumeration

None: 'none'
Thin: 'thin'
Medium: 'med '
Dashed: 'dash'
Dotted: 'dot '
Thick: 'thck'
Double underline:'dbl '
Hairline: 'hair'

or  Numeric/Text:  Instead  of  an  enumeration  code,  you  may pass  a
numeric/text value which is the same value used in the BORDER
macro.  See the Excel function reference for further details.

Notes: In  a  more  perfect  world,  a  cell  would  contain  4  border
objects, named "left," "right," "top," and "bottom,"  and each of
these  objects  would  contain  a  type  and  a  color,  but  this
implementation was chosen for simplicity.

Left Border Color
Right Border Color
Top Border Color
Bottom Border Color

Description:  The color of a cell border
Property ID: 'plbc', 'prbc', 'ptbc', 'pbbc'
Access: read/write
Data Type: 'RGB '
Notes: As indicated in the registry, the 'RGB ' data type is simply 6

bytes  corresponding  to  a  Color  QuickDraw  RGBColor  record.
Excel also includes a coercion handler to coerce from an AEList to
the RGB data type, so you can pass a list of 3 values rather than
an RGB data type if this is easier.
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Pattern
Description:  The pattern in the cell as indicated by the Patterns dialog

in the Format menu.
Property ID: 'ppat'
Access: read/write
Data Type:  typeBWPattern 'bwpt'
Notes: The type typeBWPattern is simply 8 bytes corresponding to

a  QuickDraw  Pattern  data  structure.   While  the  QuickDraw
Graphics Suite of the Apple Event Registry provides for use of a
pixelmap  to  pass  patterns  using  Apple  events,  Excel  only
supports black and white patterns, so using an entire pixelmap
data structure is not only unnecessary, but is a large amount of
work (converting a BW Pattern to a pixmap and back).  Thus, the
type  typeBWPattern  has  been  defined  for  passing  black  and
white patterns.  Excel also includes a coercion handler to coerce
from an AEList  to typeBWPattern,  so you can pass  a list  of  8
values rather than an typeBWPattern data type if this is easier.

Foreground Color
Background Color

Description:  The foreground and background colors of the pattern in
the cell as indicated by the Patterns dialog in the Format menu.
To set the color of the text in the cell,  use the Color property
below.

Property ID: 'pfcl', 'pbcl'
Access: read/write
Data Type: 'RGB '
Notes: As indicated in the registry, the 'RGB ' data type is simply 6

bytes  corresponding  to  a  Color  QuickDraw  RGBColor  record.
Excel also includes a coercion handler to coerce from an AEList to
the RGB data type, so you can pass a list of 3 values rather than
an RGB data type if this is easier.

Cell Style
Description:   The  cell's  style  as  indicated  by  the  style  tool  in  the

standard toolbar or the Style dialog in the format menu.
Property ID: 'pcsy'
Access: read/write
Data Type: 'TEXT'
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Font
Description:  The font of the text in the cell as indicated by the Font

dialog in the Format menu or the font tool in the Text Formatting
Toolbar. 

Property ID: 'font'
Access: read/write
Data Type: 'TEXT'

Font Size
Description:  The size of the font in the cell
Property ID: 'ptsz'
Access: read/write
Data Type: Any text or numeric type, or a 16.16 fixed point number

('fixd')
Notes: The  'fixd'  data  type  can  only  be  used  in  a  SetData.

GetData will always return TEXT or a numeric format.

Color
Description:  The color of the text in the cell, use the Color property

below.
Property ID: 'colr'
Access: read/write
Data Type: 'RGB '
Notes: As indicated in the registry, the 'RGB ' data type is simply 6

bytes  corresponding  to  a  Color  QuickDraw  RGBColor  record.
Excel also includes a coercion handler to coerce from an AEList to
the RGB data type, so you can pass a list of 3 values rather than
an RGB data type if this is easier.

Name
Description:  The name assigned to the cell in the name dialog in the

Formula menu
Property ID: 'pnam'
Access: read/write
Data Type: 'TEXT'
Notes: If the cell has not been assigned a name, then Excel will

return  a  text  descriptor  of  length  0,  rather  than  returning  an
error.  
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Style
Description:  The character style of the characters in the cell
Property ID: 'txst'
Access: read/write
Data Type: 'tsty' (typeTextStyles)
Notes: You can also turn individual style properties on or off, by

setting them to TRUE or FALSE, as indicated below.

Bold
Italic
Underline
Strikethrough
Outline
Shadow
Plain

Description:  Character styles of the characters in the cell
Property ID: 'bold', 'ital', 'undl', 'strk', 'outl', 'shad', 'plan'
Access: read/write
Data Type: Boolean

Elements
None

Parent Class
Document, row, column, or the application object ('null').  

Default parent classes
If you leave out the document part of the object specifier, Excel 

will assume that you are referring to the topmost Worksheet.

Naming Forms
Cells can be referred to by number or by name.  Note that in general, Excel 
only supports the absolute index and the name key forms (i.e. the test 
keyForm is not supported).

By number:
• When referring to a cell in a row, the leftmost cell is cell 1, and the 
rightmost cell in the row is 256.

i.e. cell 6 of row 2

• When referring to a cell in a column, the topmost cell is cell 1, and the 
bottomost cell is 16384.
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i.e. cell 32 of column 8

• When referring to a cell in a document, numering starts at the upper left, 
and proceeds in row-major order.  Thus, A1 is cell 1, B1 is cell 2, A2 is 257, 
etc.

By name
To refer to a cell by name, you can use R1C1 style addressing, or use a name
that has been defined on a spreadsheet.  Thus, one can speak about "the cell
named R5C5" and "the cell named Sales."

Apple Events

• GetData
• SetData
• Delete Deleting a cell object is defined as clearing that cell
• Clone A cell can be cloned or moved into another cell or into a range 

object.  When describing the destination object, the only valid 
preposition is 'rplc' (replacing), that is, before and after are not 
supported.  When a cell is cloned into a range, the cell is cloned 
into every cell of the range.

• Move
• Create Publisher any cell or range of cells can be published
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External Form

As the Apple Event Registry indicates, a cell object is an Apple event record 
of type 'cell' (typeCell), where each of the cell's properties is expressed in a 
keyWord parameter.  Just as Excel has extended the definition of the cell  object 
beyond its definition in the registry (by adding more properties), it has also 
extended the Registry's definition of the typeCell AppleEvent record.  Excel's cell 
object simply contains more keyword parameters than the object in the registry 
(because there are more properties).

That said, here is Excel' cell object, an Apple event record of type'cell'  
(typeCell).

Property Name KeyWord Type
Protection 'kptc' 'enum'  (see description 

above)
Formula 'kfla' 'TEXT'
Value 'kval' 'TEXT'
Text 'ktxt' 'TEXT'
Number Format 'knft' 'TEXT'
Alignment 'klig' 'enum'  (see description 

above)
Left Border 'klbr' 'enum'  (see description 

above)
Right Border 'krbr' 'enum'  (see description 

above)
Top Border 'ktbr' 'enum'  (see description 

above)
Bottom Border 'kbbr' 'enum'  (see description 

above)
Left Border Color 'klbc' 'RGB ' (6 bytes)
Right Border Color 'krbc' 'RGB ' (6 bytes)
Top Border Color 'ktbc' 'RGB ' (6 bytes)
Bottom Border Color 'kbbc' 'RGB ' (6 bytes)
Pattern 'kpat' 'bwpt' (8 bytes)
Foreground Color 'kfcl' 'RGB ' (6 bytes)
Background Color 'kbcl' 'RGB ' (6 bytes)
Cell Style 'kcsy' 'TEXT'
Font 'kont' 'TEXT'
Size 'ktsz' 'TEXT'
Color 'kolr' 'RGB ' (6 bytes)
Name 'knam' 'TEXT'
Style 'kxst' 'tsty' (a record of 2 lists)
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2. The Range/Table Object

Class: 'crng' / 'ctbl'
Default Data Type: 'rang', a list of lists   /  'tabl'  (typeTable)

Notes:

• The table suite was not really designed with spreadsheets in mind.
One example is the table data type (typeTable), an Apple event record with
fields for name, protection, and finally, a row list.  Spreadsheet ranges do not
have protections distinct from the protections of their cells, and most do not
have names distinct from their locations on the sheet (e.g. R1C1:R4C4).  In
returning the information for a range, then, one option was to use the table
data type, and then just use the rowlist  field.   This,  however,  introduces
needless complexity as well as an extra indirection.  Thus, Excel returns the
data for a range in a list of lists, where each sublist contains data for one
row.

However, for compatibility, Excel also supports the table data type, as
defined in the table suite chapter of the registry

• You can GetData a property of a range or a range itself.  When you
GetData a property of a range, Excel returns a list of lists (as described in the
previous paragraph), where each sublist contains the values of the property
for  a  row  of  the  range.   For  example  if  the  font  of  A1  was  Times,  B1
Helvetica,  A2  Courier  and  B2  New York,  Get  Data  the  font  of  the  range
named R1C1:R2C2  would  return  [[Times,  Helvetica],  [Courier,  New York]].
When you GetData a range (as opposed to a property of that range), Excel's
actions  depend  on  the  keyAERequestedType  parameter  to  the  GetData
AppleEvent.  If it is typeCell ('cell'), typeRange ('rang') or ommitted, Excel
returns  a  list  of  lists  of  cell  objects,  whose  structure  is  described  in  the
external form section of the cell object.   If  typeText ('TEXT') is requested,
Excel returns a list of lists of formulas (identical to requesting the formula
property of the range).   If any numeric type is requested, Excel returns a list
of lists of values (identical to requesting the value property of the range).

Everything in the previous paragraph also refers to tables, except you
would use cTable ('ctbl') and typeTable ('tabl') instead of cRange ('crng') and
typeRange ('rang').
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• You can SetData a range or property of a range in two ways -- you
can pass Excel a list of lists containing the values of the properties or cell
objects (just like the GetData event would return).  In this case, Excel will
iterate  through  the  range,  applying  values  in  the  list  of  lists  to  the
corresponding cell  in the range.  Alternatively, you can pass just one value,
in which case this value is applied to all cells in the range.

 • One exception to the above GetData and SetData rules is the name
property of a range, which applies to the entire range, not to each cell of the
range individually.

Properties

All the properties of the cell object can be used wuth the range object.  The
use of the GetData and SetData events is described in  the notes above.

Elements
None

Parent Class
Document, or the application object ('null').  

Default parent classes
If you leave out the document part of the object specifier, Excel 

will assume that you are referring to the topmost Worksheet.

Naming Forms

Ranges can be referred to by name in R1C1 format, e.g. "R5C5:R11C18," or 
by name, if you've named a range of cells (with Define Name).

Apple Events

• GetData See notes above
• SetData See notes above

• Clone A range can be cloned or moved into another range 
object.  When describing the destination object, the only valid 
preposition is 'rplc' (replacing), that is, before and after are not 
supported.

• Move
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External Form

As described above, a list of lists, where each lists contains data for one row
is used to transport range objects.  The individual descriptors in each of the
sublists  can  be  of  several  data  types.   In  addition  to  allowing  you  to
specify/ask for data elements as cell objects, you can also specify them as
text or any numeric format.  For example, if you wanted all the values of a
range of cells as IEEE floating point numbers, you would use the type 'doub'
in the GetData event,  and you would get a list of lists of  these numbers
rather than a list of cell objects (you could also do this by GetData-ing the
value property of the range).  When you leave out the type parameter, or ask
for type cell or range/table, you get a list of list of cell objects, which are just
Apple event records, as described above.

3. The Row Object

Class: 'crow'
Default Data Type: None

Properties

Height
Description:  The height of the row as expressed in the Row Height

command in the Format Menu
Property ID: 'prhi'
Access: read/write
Data Type: Any text or numeric format
Note:  Either  text  or  a  numeric  format may be sent  with  a  SetData

event, since the AE Manager will automatically coerce these as
needed.  In  response to a GetData event,  however,  Excel  will
always return TEXT, unless it  is  asked to coerce to a numeric
type (with the requested type parameter to the GetData event).

Elements
Cell

Parent Class
Document, or the application object ('null').  

Default parent classes
If you leave out the document part of the object specifier, Excel 

will assume that you are referring to the topmost Worksheet.
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Naming Forms
Rows may be referred to only by number, i.e.  "Row 6."

Apple Events

• GetData
• SetData
• Create You can insert rows in two ways:

a) You can insert a row before or after another row, i.e. Create 
row after row 3.
b) If you have no destination object, or if the destination object is
a document, then Excel will insert as many rows as are selected 
before the selection (just like the Insert... command on the Edit 
Menu does).
Note that Excel does not examine the keyAEPropData paramter 
to the Create element AppleEvent.

• Delete Deleting a row is equivalent to the Delete command on the Edit 
menu

• Clone A row can be cloned or moved into another row object.  When 
describing the destination object, the only valid preposition is 
'rplc' (replacing), that is, before and after are not supported.

• Move
• Count ElementsYou can count how many rows are in a document.  This lets

you know the position of the last non-empty row in the 
document.

External Form
None.  That is,  you can't say "get row 1 of document 1."
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4. The Column Object

Class: 'ccol'
Default Data Type: None

Properties

Width

Description:   The width  of  the column as  expressed in  the Column
Width command in the Format Menu

Property ID: 'pcwi'
Access: read/write
Data Type: Any text or numeric format
Note:  Either  text  or  a  numeric  format may be sent  with  a  SetData

event, since the AE Manager will automatically coerce these as
needed.  In  response to a GetData event,  however,  Excel  will
always return TEXT, unless it  is  asked to coerce to a numeric
type (with the requested type parameter to the GetData event).

Elements
Cell

Parent Class
Document, or the application object ('null').  

Default parent classes
If you leave out the document part of the object specifier, Excel 

will assume that you are referring to the topmost Worksheet.

Naming Forms
Columns may be referred to by number or by name, i.e.  "Column  6," or 
"Column J."  Note that when referring to a column by name, you use the 
columns letter, that is, the tenth column is referred to as column J, not 
column C10.

Apple Events

• GetData
• SetData
• Create You can insert columns in two ways:

a) You can insert a column before or after another column, i.e. 
Create column after column 3.
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b) If you have no destination object, or if the destination object is
a document, then Excel will insert as many column as are 
selected before the selection (just like the Insert... command on 
the Edit Menu does).
Note that Excel does not examine the keyAEPropData paramter 
to the Create element AppleEvent.

• Delete Deleting a column is equivalent to the Delete command on the 
Edit menu

• Clone A column can be cloned or moved into another column object.  
When describing the destination object, the only valid 
preposition is  'rplc' (replacing), that is, before and after are not 
supported.

• Move
• Count ElementsYou can count how many columns are in a document.  This 

lets you know the position of the last non-empty column in the 
document.

External Form
None.  That is,  you can't say "get column 1 of document 1."

5. The Document Object

Class: 'docu'
Default Data Type: 'TEXT'

Note: When you GetData a document object, you get the document's name.
You cannot SetData a document object.

Properties

Name
Description:  The name of the document
Property ID: 'pnam'
Access: read-only
Data Type: 'TEXT'
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Pathname
Description:  The pathname of the document (this does not include the

document name).  If the document has not been saved, GetData
will return an error.

Property ID: 'ppth'
Access: read-only
Data Type: 'TEXT'

Type
Description:  The type of the document
Property ID: 'ptyp'
Access: read-only
Data Type: Enumeration:

Worksheet: 'wkst'
Macro Sheet: 'mcro'
Chart Sheet: 'chrt'
Workbook: 'wkbk'
Clipboard Window: 'clip'
Info Window: 'info'

Modified
Description:  Tells whether the document is "dirty."
Property ID: 'imod'
Access: read-only
Data Type:  Boolean

Cell Protection
Object Protection

Description:  Indicates whether cells or objects are protected on this
sheet.   These  settings  correspond  to  the  checkboxes  in  the
Protect Document dialog accessed through the Options menu.

Property ID: 'pcpr', 'popr'
Access: read/write
Data Type: Enumeration:

Read Only 'nmod'
Read/Write 'modf'

Number of Windows
Description:  The number of windows currently visible on the document
Property ID: 'pnwn'
Access: read-only
Data Type:  'long'
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Selection or User Selection
Description:  The current selection on the document
Property ID: 'sele' or'pusl'
Access: read/write
Data Type:  'TEXT' or 'obj '
Notes: Cell selections can be gotten/set using either an object specifier

or  a  textual  representation  ("R1C1:R5C4").   If  the  current
selection is Excel's object layer (i.e. a rectangle, oval,  button),
then only the textual representation may be used.  To change the
current  document,  set  the  selection  of  the  application  object
('null') to a document object.

Excel  treats  the  selection  and  user  selection  properties
identically.

Protection
Description:  Indicates whether or not the document is modifiable
Property ID: 'ppro'
Access: read-only
Data Type: Enumeration:

Read Only 'nmod'
Read/Write 'modf'

All  window  properties  are  also  valid  for  documents.   Window
properties  include  Bounds,  Has  Title  Bar,  Index,  Is  Floating,  Is
Modal, Is Resizable, Is Zoomed,  and IsVisible.  See the description
of the window object for more information.

Elements
Cell, Row, Column, Window

Parent Class
The application object ('null').  

Naming Forms
Documents may be referred to by number (in which case z order) is used, or 
by name (in which case the name in the title bar is used).

Apple Events

• GetData
• SetData
• Create You  can  specify  the  type  of  the  newly  created  document  by

passing the document type in the keyAEData paramter of the Create
AppleEvent.  You can either pass an enumeration value (described 
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under the type property), or pass the same text/numeric value passed to the
Excel NEW() macro.

Note that Excel does not examine the keyAEPropData paramter 
to the Create Element AppleEvent.

• Save Excel will only bring up the standard file dialog if the 
interaction level of the Apple event is set to kAEAlwaysInteract.

• Close
• Print Excel will only bring up the print dialog if the interaction 

level of the Apple event is set to kAEAlwaysInteract.
• Revert
• Count ElementsYou can count the number of documents in the application 

object ('null')

External Form

None.  Doing a GetData on a document object will return the document's 
title.  You can't do a SetData on a document object.
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6. The Window Object

Class: 'cwin'
Default Data Type: 'TEXT'

Note:   The word "window" means two different things in Excel.  On the one
hand, there are windows on the screen, so you can refer to window 1 or
window 2.  In this case, the application object ('null') is the parent class
of the window.  In addition, a document can also have several windows.
In this case, the windows, created with the New Window command the
the Window menu, are different views on the document.  Thus, you can
refer to "window 2 of document 1."  In this case, the parent class of the
window  is  a  document.   In  Excel  4.0,  you  cannot  refer  to  floating
windows with Apple events.

When you GetData a window object, you get the document's name.  You
cannot SetData a window object.

Properties

Name
Description:  The name of the window
Property ID: 'pnam'
Access: read-only
Data Type: 'TEXT'

Type
Description:  The type of the document the window belongs to
Property ID: 'ptyp'
Access: read-only
Data Type: Enumeration:

Worksheet: 'wkst'
Macro Sheet: 'mcro'
Chart Sheet: 'chrt'
Workbook: 'wkbk'
Clipboard Window: 'clip'
Info Window: 'info'
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Selection or User Selection
Description:  The current selection on the window
Property ID: 'sele' or 'pusl'
Access: read/write
Data Type:  'TEXT' or 'obj '
Notes: Cell  selections  can  be  gotten/set  using  either  an  object

specifier  or  a  textual  representation  ("R1C1:R5C4").   If  the
current selection is in Excel's object layer (i.e. a rectangle, oval,
button),  then only the textual  representation may be used. To
change the current window, set the selection of the application
object ('null') to a window object.

Excel  treats  the  selection  and  user  selection  properties
identically.

Bounds
Description:  The bounding rectangle of the window
Property ID: 'pbnd'
Access: read/write
Data  Type:   'qdrt'   (typeQDRectangle),   8  bytes  specifying  the

rectangle's coordinates
Notes: Using the SetData AppleEvent, you can position the window in a

position that the user would not ordinarily be able to put it, so be
careful.

Has Title Bar
Description:  A boolean indicating whether the window has a title bar
Property ID: 'ptit'
Access: read-only
Data Type:  'bool'
Note: All Excel windows have titlebars.
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Is Floating
Description:   A boolean indicating whether the window is  a floating

toolbar
Property ID: 'isfl'
Access: read-only
Data Type:  'bool'
Note: Excel 4.0 does not allow you to refer to floating windows with

Apple events, so doing a GetData on this property will  always
return false.

Is Modal
Description:   A  boolean  indicating  whether  the  window  is  a  modal

dialog
Property ID: 'pmod'
Access: read-only
Data Type:  'bool'

Is Resizable
Description:  A boolean indicating whether the window is resizable
Property ID: 'prsz'
Access: read-only
Data Type:  'bool'
Note: All non-modal Excel windows are resizable.

Is Zoomed
Description:  A boolean indicating whether the window is zoomed
Property ID: 'pzum'
Access: read/write
Data Type:  'bool'

Is Visible
Description:  A boolean indicating whether the window is visible
Property ID: 'pvis'
Access: read/write
Data Type:  'bool'

Index
Description:  The z order of the window
Property ID: 'pidx'
Access: read-only
Data Type:  Any text or numeric data type

Elements
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None

Parent Class
Document, or the application object ('null'), as described above.  

Naming Forms
Windows may be referred to by number (in which case z order) is used, or by 
name (in which case the name in the title bar is used).

Apple Events

• GetData
• SetData
• Create The Create Element Apple event creates a new window (a new

view) on an existing document.   If  you really want to create a new
document, make a document the object type you want to create.

Note that Excel does not examine the keyAEPropData paramter 
to the Create Element AppleEvent.

• Close

External Form

None.  Doing a GetData on a window object will return the window's title.   
You can't do a SetData on a window object.
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7. The File Object

Class: 'file'
Default Data Type: none

Properties
None.  If you think about it, it's really the Finder's job to give

you information about files, not Excel.  The raison d'etre of Excel's
file object is to allow you to open and print files using the object
model.

Elements
None

Parent Class
The application object ('null').  

Naming Forms
Files can only be referred to by name.  The name is interpreted as a relative 
pathname of a full pathname, using the same rules that Excel and the 
Macintosh OS use.  Excel contains a coercion handler that maps text to an 
alias record.

Apple Events

• Open
• Print

External Form

None.  Doing a GetData on a file object will fail.
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8. The Application Object

Class: 'null'
Default Data Type: none

Properties

Clipboard
Description:  The contents of the clipboard
Property ID: 'pcli'
Access: read-only
Data Type:  any legal clipboard type; if omitted, PICT is used
Note:  The Macintosh Toolbox  doesn't "properly" handle the case of a

background  application  accessing  the  clipboard  (that  is,
GetScrap and PutScrap do not operate on the data pointed to by
the  low  memory  global  ScrapHandle).   Thus,  getting  the
clipboard property has some restrictions.   Basically,  when you
GetData  the clipboard,  the application  should  be  in  the same
state (foreground or background) that is was when the data was
put on the clipboard (e.g if the app is in the background when
you send the GetData, the data should also have been copied to
the  clipboard  when  the  app  was  in  the  background  (and  the
same for foreground).

Is Front Process
Description:  A  boolean  indicating  whether  Excel  is  the  foreground

application
Property ID: 'pisf'
Access: read-only
Data Type:  'bool'

Text Item Delimiter
Description:  The character Excel uses to delimit items in lists
Property ID: 'txdl'
Access: read-only
Data Type:  'TEXT'
Note: It's a comma.

Version
Description:  The version of Excel being used
Property ID: 'vers'
Access: read-only
Data Type:  'long'
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Note: This returns the version longword.  For Excel 4.0, it's
(obviously) 0x00040000.

Calculation
Description:  Excel's current recalculation mode
Property ID: 'pclc'
Access: read/write
Data Type: Enumeration

Automatic: 'auto'
Automatic Except Tables: 'antb'
Manual: 'manl'

or Numeric/Text: Instead of an enumeration code, you may pass
a  numeric/text  value  which  is  the  same  value  used  in  the
CALCULATION  macro.   See  the  Excel  function  reference  for
further details.

Notes: This property corresponds to the calculation radio group in
the Calculation dialog under the Options menu. 

Iteration
Description:  A boolean indicating whether or not iteration is turned on
Property ID: 'pitr'
Access: read/write
Data Type: 'bool'
Notes: This property corresponds to the iteration checkbox in the

Calculation dialog under the Options menu. 
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Name
Description:  The localized name of Excel, as shown in the About Box
Property ID: 'pnam'
Access: read-only
Data Type: 'TEXT'

Selection or User Selection
Description:  The current selection  in Excel
Property ID: 'sele' or'pusl'
Access: read/write
Data Type:  'TEXT' or 'obj '
Notes:  The selection can be set to a cell  or range, items in Excel's

object layer, or a document.  Selecting items in a chart is not
supported.

Cell selections can be gotten/set using either an object specifier
or  a  textual  representation  ("R1C1:R5C4").   If  the  current
selection is Excel's object layer (i.e. a rectangle, oval,  button),
then only the textual representation may be used.

Unlike  the  selection  property  of  documents  and  windows,  the
selection property of the application object contains either the
document name (if text is being returned) or a document object
(if an object specifier is being used).

To  change  the  current  document,  set  the  selection  of  the
application object ('null') to a document object.

Excel  treats  the  selection  and  user  selection  properties
identically.

Elements
Documents, Windows, Rows, Columns, Cells, Ranges, Files, Charts, 

Axes, Series

Naming Forms
None

Apple Events

• GetData
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• SetData
• Count Elements You can count the number of open documents.

External Form

None.  Doing a GetData on a application object will fail.
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9. The Chart Object

Class: 'chrt'
Default Data Type: 'PICT' or 'SPIC' 

Notes:
• When you do a GetData on a chart object, you get a PICT that is

rendered for printing, which will typically be black and white (unless the print
with color checkbox of the print dialog was set).  If you want a color chart ,
set the desired data type of the GetData event to 'SPIC' (for screen picture).

• Excel contains 2 kinds of charts--chart documents and chart objects
that exist on Worksheets.  You may refer to either with Apple events.  To refer
to a chart doucments, use a parent class of 'null',  and to refer to a chart
object on a worksheet, use a parent class of document.

• Apple events in Excel 4.0 only provide access to main charts, not
overlay charts.

Properties
Title

Description:  The title of the chart
Property ID: 'pttl'
Access: read/write
Data Type:  A chart title is an object of class ChartText, which means

you can gert/set font name, font size, color, style and individual
style  elements,  pattern,  and  the  pattern's  forecolor  and
backcolor.  See the class ChartText for more information.

The Class ChartText
Class:'cctx'
Default Data Type: none

Note  that  there  is  no  actual   ChartText  object  in  Excel.
Rather,  other  objects  (that  are  properties)  are  of  the  class
ChartText (for example, a chart title, or an axis label).  Thus, you
never refer to "the ChartText of ..."  Instead, you refer to "the title
of chart 1," or "the label of axis "category" of chart 1."

Properties
Font
Description:  The font of the text in the cell as indicated by the
Font  dialog  in  the  Format  menu  or  the  font  tool  in  the  Text
Formatting Toolbar. 
Property ID: 'font'
Access: read/write
Data Type: 'TEXT'
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Size
Description:  The size of the font in the cell
Property ID: 'ptsz'
Access: read/write
Data  Type:  Any  text  or  numeric  type,  or  a  16.16  fixed  point
number ('fixd')
Notes: The 'fixd' data type can only be used in a SetData.
GetData will always return TEXT or a numeric format.

Color
Description:  The color of the text.
Property ID: 'colr'
Access: read/write
Data Type: 'RGB '
Notes: As  indicated  in  the  registry,  the  'RGB '  data
type  is  simply  6  bytes  corresponding  to  a  Color
QuickDraw  RGBColor  record.   Excel  also  includes  a
coercion handler to coerce from an AEList to the RGB data
type, so you can pass a list of 3 values rather than an
RGB data type if this is easier.  
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Style
Description:  The character style of the characters in the cell
Property ID: 'txst'
Access: read/write
Data Type: 'tsty' (typeTextStyles)
Notes: You can also turn individual style properties on or off,
by setting them to TRUE or FALSE, as indicated below.

Bold
Italic
Underline
Strikethrough
Outline
Shadow
Plain
Description:  Character styles of the characters in the cell
Property ID: 'bold', 'ital', 'undl', 'strk', 'outl', 'shad', 'plan'
Access: read/write
Data Type: Boolean

Pattern
Description:  The pattern in the cell as indicated by the Patterns
dialog in the Format menu.
Property ID: 'ppat'
Access: read/write
Data Type:  typeBWPattern 'bwpt'
Notes: The  type  typeBWPattern  is  simply  8  bytes
corresponding to a QuickDraw Pattern data structure.  While the
QuickDraw Graphics Suite of the  Apple Event Registry provides
for use of a pixelmap to pass patterns using Apple events, Excel
only  supports  black  and  white  patterns,  so  using  an  entire
pixelmap data structure is not only unnecessary, but is a large
amount of work (converting a BW Pattern to a pixmap and back).
Thus, the type typeBWPattern has been defined for passing black
and white patterns.    Excel also includes a coercion handler to
coerce from an AEList to typeBWPattern, so you can pass a list of
8 values rather than an typeBWPattern data type if this is easier.

Foreground Color
Background Color
Description:   The  foreground  and  background  colors  of  the
pattern  in  the  cell  as  indicated  by  the  Patterns  dialog  in  the
Format menu.  To set the color of the text, use the Color property
above.
Property ID: 'pfcl', 'pbcl'
Access: read/write
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Data Type: 'RGB '
Notes: As indicated in the registry, the 'RGB ' data type is
simply  6  bytes  corresponding  to  a  Color  QuickDraw RGBColor
record.  Excel also includes a coercion handler to coerce from an
AEList to the RGB data type, so you can pass a list of 3 values
rather than an RGB data type if this is easier.
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Number of Series
Description:  The number of series in the chart
Property ID: 'pcsr'
Access: read-only
Data Type:  any text or numeric type

Type
Description: The type of chart
Property ID: 'ptyp'
Access: read/write
Data Type: Enumeration

Area: 'area'
Bar: 'bar '
Column: 'col '
Line: 'line'
Pie: 'pie '
Scatter: 'xy  '
Three D Area: '3ara'
Three D Column: '3col'
Three D Line: '3lin'
Three D Pie: '3pie'
Three D Bar: '3bar'
Three D Surface: '3sur'
Radar: 'radr'

or Numeric/Text: Instead of an enumeration code, you may pass
a  numeric/text  value  which  is  the  same  value  used  in  the
FORMAT.MAIN  macro.   See  the  Excel  function  reference  for
further details.

Variant
Description:   The  variant  of  the  chart  type,  as  shown  in  the  chart

gallery
Property ID: 'pcvr'
Access: read/write
Data Type: any TEXT or numeric format
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Has Legend
Description:  A boolean indicating whether the chart has a legend
Property ID: 'phld'
Access: read/write
Data Type:  'bool'

Pattern
Description:  The pattern of the chart background as indicated by the

Patterns dialog in the Format menu.
Property ID: 'ppat'
Access: read/write
Data Type:  typeBWPattern 'bwpt'
Notes: The type typeBWPattern is simply 8 bytes corresponding to

a  QuickDraw  Pattern  data  structure.   While  the  QuickDraw
Graphics Suite of the Apple Event Registry provides for use of a
pixelmap  to  pass  patterns  using  Apple  events,  Excel  only
supports black and white patterns, so using an entire pixelmap
data structure is not only unnecessary, but is a large amount of
work (converting a BW Pattern to a pixmap and back).  Thus, the
type  typeBWPattern  has  been  defined  for  passing  black  and
white patterns.  Excel also includes a coercion handler to coerce
from an AEList  to typeBWPattern,  so you can pass  a list  of  8
values rather than an typeBWPattern data type if this is easier.

Foreground Color
Background Color

Description:  The foreground and background colors of the pattern of
the chart background as indicated by the Patterns dialog in the
Format menu.

Property ID: 'pfcl', 'pbcl'
Access: read/write
Data Type: 'RGB '
Notes: As indicated in the registry, the 'RGB ' data type is simply 6

bytes  corresponding  to  a  Color  QuickDraw  RGBColor  record.
Excel also includes a coercion handler to coerce from an AEList to
the RGB data type, so you can pass a list of 3 values rather than
an RGB data type if this is easier.

Elements
Axis, Series

Parent Class
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Document, or the application object ('null'), as described above.  

Naming Forms
If referring to a chart document (the parent class in 'null'), then charts 

may be referred to by name or by z order (this z order applies only to chart 
documents, ignoring all other types of documents). 

When referring to a chart object on a worksheet, charts may be 
referred to by name (in which case the object name is used, i.e. "Chart 5"), 
or by number, in which case Excel looks at all chart objects, and returns the 
one in the positionyou specify (thus, if there are 3 chart objects, "Chart 5," 
"Chart 7," and ""Chart 14", asking for chart 2 refers to "Chart 7."

Apple Events

• GetData
• SetData
• Create To create a  new chart,  first  set  the selection property (of  the

application or a document) to the data you want to chart (yes, this is
unfortunate,  but  is  pretty fundamental  to Excel).   To create a chart
document, use the class chart ('chrt') as the class of object to create,
and  omit  the  container  parameter.   To  create  a  chart  object  in  a
worksheet, use the class chart ('chrt') as the class of object to create,
and make the chart's container a range object.

When a new chart is created by the user, and the first column
contains  numeric data, Excel typically asks the user whether the first
column contains the first data series, X axis labels, or X values for an
XY chart.   To  pass  the  same information  to  Excel,  you  can pass  a
text/numeric value in the keyAEData parameter of the Create element
AppleEvent.   Pass 1,2, or 3.  If this value is left out, Excel assumes 1
(first data series).

Note that Excel does not examine the keyAEPropData paramter 
to the Create Element AppleEvent.

• Delete You can only delete a chart object on a Worksheet.  To delete a
chart document, send a close event to the document object.

• Clone
You can copy a chart or chart object into the clipboard (with the Copy
AppleEvent), or you can clone a chart document "into" a range of cells
on a Worksheet (thus converting a chart document into a chart object
on a Worksheet).  Use the preposition 'rplc' (replacing) in the insertion
loc parameter in the clone event.

• Create Publisher

External Form
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As described in the note above, PICT is the only external form for charts 
(there is no chart AERecord).
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10. The Series Object

Class: 'cser'
Default Data Type: typeSeries ('sers'), an Apple event record 

Notes:

• You can only use Apple events to access series in a main chart, not
an overlay chart.

• You can manipulate series objects, i.e. get series 1 of chart 1, or set
series 4 of chart 2 to <a series object>, or Create series after series 4,
etc.

Properties

Name
Description:  The name of the series
Property ID: 'pnam'
Access: read-only
Data Type:  If a series does not have an explicit name (that is, if there

was no series label in the data that created the chart, series are
named "Series 1, Series 2," etc.

Pattern
Description:   The pattern of  the series as indicated by the Patterns

dialog in the Format menu.
Property ID: 'ppat'
Access: read/write
Data Type:  typeBWPattern 'bwpt'
Notes: The type typeBWPattern is simply 8 bytes corresponding to

a  QuickDraw  Pattern  data  structure.   While  the  QuickDraw
Graphics Suite of the Apple Event Registry provides for use of a
pixelmap  to  pass  patterns  using  Apple  events,  Excel  only
supports black and white patterns, so using an entire pixelmap
data structure is not only unnecessary, but is a large amount of
work (converting a BW Pattern to a pixmap and back).  Thus, the
type  typeBWPattern  has  been  defined  for  passing  black  and
white patterns.  Excel also includes a coercion handler to coerce
from an AEList  to typeBWPattern,  so you can pass  a list  of  8
values rather than an typeBWPattern data type if this is easier.
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Foreground Color
Background Color

Description:  The foreground and background colors of the pattern of
the  series  as  indicated  by  the  Patterns  dialog  in  the  Format
menu.

Property ID: 'pfcl', 'pbcl'
Access: read/write
Data Type: 'RGB '
Notes: As indicated in the registry, the 'RGB ' data type is simply 6

bytes  corresponding  to  a  Color  QuickDraw  RGBColor  record.
Excel also includes a coercion handler to coerce from an AEList to
the RGB data type, so you can pass a list of 3 values rather than
an RGB data type if this is easier.

Elements
None

Parent Class
Chart, or the application object ('null').  

Default parent classes
If you leave out the chart part of the object specifier, Excel will 

assume that you are referring to the topmost sheet.  If the topmost 
sheet is not a chart, an error will be returned.

Naming Forms
A series may be referred to by name or number.  When referring to a 

series by name, you can either use the series' actual name, if it has one, or 
"Series n" for the nth series, if that series does not have a name.

Apple Events

• GetData
• SetData
• Create A  new  series  can  be  created  before,  after,  or  replacing  an

existing series.  The keyAEData parameter of the Create Element Apple
event should be a series object -- an  Apple event record of type series.

• Delete You can only delete a chart object on a Worksheet.  To delete a
chart document, send a close event to the document object.

External Form
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The external form of a series is typeSeries ('sers') which is an Apple event 
record with 2 elements:

keyAEName 'knam' a descriptor of type 'TEXT' with the 
series' name

keyAESeriesData 'kcsd' an Apple event list of typePoint ('srpt') Apple event 
records,

where the point record is as follows:

keyAEYValue 'kcyv'an IEEE floating point number ('doub') with the 
Y value of the point

keyAEXValue 'kcxv'an IEEE floating point number ('doub') with the 
X value of the point

or: keyAEXLabel 'kcxl' a 'TEXT' descriptor for the X label of the point

(scatter and surface (x/y) charts use keyAEXValue, and all other charts use 
keyAEXLabel)
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11. The Axis Object

Class: 'ccax'
Default Data Type: none

Notes:

• You can only use Apple events to access the axes of a main chart, not
an overlay chart.

Properties

Label
Description:  The label of the axis
Property ID: 'paxl'
Access: read/write
Data Type:  An axis label is an object of class ChartText, which means

you can gert/set font name, font size, color, style and individual
style  elements,  pattern,  and  the  pattern's  forecolor  and
backcolor.  See the class ChartText (described above) for more
information.

Is Visible
Description:  A boolean indicating whether or not the axis is visible
Property ID: 'pvis'
Access: read/write
Data Type:  'bool'

Min
Max

Description:  The minimum and maximum values on the axis
Property ID: 'pamn', 'pamx'
Access: read/write
Data Type:  'TEXT' or any numeric type
Note:  You can only set these properties on the y axis (or the x

axis  of  a  scatter  chart).   Whenever  Excel  can return  TEXT or
numeric  data  in  response  to  a  GetData  event,  Excel  always
returns TEXT unless you ask for a specific numeric type.

Major Step
Minor Step

Description:  The major and minor step values along the axis
Property ID: 'pajs', 'pans'

42



Apple Events and Microsoft Excel 4.0

Access: read/write
Data Type:  'TEXT' or any numeric type
Note:   The minor  step value  only  matters  when minor  tick  type  is

semething other than 'none'.  
You can only set these properties on the y axis (or the x axis of a
scatter chart).  Whenever Excel can return TEXT or numeric data
in response to a GetData event, Excel always returns TEXT unless
you ask for a specific numeric type.  

Major Tick Type
Minor Tick Type

Description: The kind of tick mark Excel uses at major and minor step
increments

Property ID: 'pajt', 'pant'
Access: read/write
Data Type: Enumeration

None: 'none'
Inside: 'insi'
Outside: 'outs'
Cross: 'cros'

or Numeric/Text: Instead of an enumeration code, you may pass
a  numeric/text  value  which  is  the  same  value  used  in  the
PATTERNS macro.  See the Excel function reference for further
details.

Elements
None

Parent Class
Chart, or the application object ('null').  

Default parent classes
If you leave out the chart part of the object specifier, Excel will 

assume that you are referring to the topmost sheet.  If the topmost 
sheet is not a chart, an error will be returned.

Naming Forms
Axes may be referred to by name or by number.  When referring to 

axes by name, you can use either "X," "Y," or "Z," or "Category," "Value," or 
"Series."  When referring to axes by number the x, y, and z axes are always 
1, 2, or 3.
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Apple Events

• GetData
• SetData

External Form

None, that is, you can't do a GetData on an axis object.  

III.  Excel's Additional Apple Events

1. The Recalculate AppleEvent

The recalculate Apple event forces a recalculation of all sheets.  This useful if
recalculation  has  been  set  to  manual  (calculation  mode  is  a  property  of  the
application object, described above).

Class: 'XCEL'
Event ID: 'rclc'

Parameters: None

Return Value: None (this always succeeds)

2. The DoMacro or DoScript AppleEvent

This Apple event allows you to pass Excel a function or macro to evaluate
/execute, or a list of functions and macros to be evaluated/executed.  Excel returns
the results of evaluating/executing the function(s) and macro(s).  If Excel is passed
a single function/macro, it returns a single result; if passed a list, Excel will return a
list of results.

Almost any legal expression can be used.  For example, you could evaluate
SIN(PI()/2)*COS("R1C1"), or PATTERNS(1,1,1).  This Apple event is a good way to
access Excel's functionality if you haven't mastered the Apple Event Object Model,
or if the things you want to do are not accessible via the Excel object model (i.e.
changing the date mode from 1904 to 1900).
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You should not precede your command with an equals sign, as you would in a
macro sheet.  Also, all of your references must be quoted R1C1 format references.

Class: 'XCEL' or Class:'aevt'
Event ID: 'mcro' EventID: 'dosc'

Parameters: The direct parameter should either be a single TEXT 
descriptor that is the function or macro to be executed or an Apple event list of 
functions/macros to be executed.

Results: The direct parameter of the result contains either a single value 
or an Apple event list of values containing the results of evaluaing/executing the 
function(s) or macro(s) that were passed to Excel.
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